
About Multi-Objective-OPT 

Welcome to Multi-Objective-OPT. Multi-Objective-OPT is a Microsoft Excel COM Add-in that finds one or more optimized solutions for one or more Objectives. The optimization is 
performed by utilizing OPTIMUM’s proprietary expert Design of Experiments and optimization technology (U.S. Patent 7,260,516) while varying the specified DesignSpaceVariables within 
a defined Design Space. 

The Multi-Objective-OPT family of products consists of: 

� Multi-Objective-OPT10: up to 10 DesignSpaceVariables, up to 5 Objectives, up to 20 Solutions

Installing Multi-Objective-OPT

Multi-Objective-OPT is installed by running Setup.exe. Before running setup, please make sure your system meets the minimum hardware and software requirements. 

Multi-Objective-OPT Hardware Requirements

� CPU: 500 MHz processor or faster

� RAM: 256MB or more

� Hard Disk Space: 100 MB free space required for install

� Monitor: 800 X 600 or higher

� Internet connectivity is required for installing on Microsoft Windows XP if the .NET Framework 3.5 and .NET Framework 4.0 are not already installed

Multi-Objective-OPT Software Requirements

� Operating System: Microsoft Windows XP with Service Pack 2, Vista, or Windows 7

� Microsoft Office: 2003, 2007, or 2010

� Additional Software included and automatically installed by setup if necessary:

Microsoft Windows Installer 3.1 

Microsoft Windows Imaging Components (installed as a component of the Microsoft .NET Framework 3.5 if necessary) 

Microsoft .NET Framework 4.0 

Microsoft Office and Excel Primary Interop Assemblies 

Update KB908002 for .NET Framework and Office 

Multi-Objective-OPT Serial

Multi-Objective-OPT version, options and expiration date are controlled by a Serial. A Serial is a string of upper case letters and numbers similar to the following: 

ABCDEFGH-01234567-IJKLMNOP-98765432 

When Multi-Objective-OPT starts for the first time, it will request a Serial. If you do not specify a Serial, Multi-Objective-OPT will terminate. 

Multi-Objective-OPT Setup

After Setup starts, it verifies that each required software component is installed, if a required software component is not installed, Setup automatically installs it. This process could take 
from several seconds to 20 minutes or more depending on which software components need to be installed and the speed of your computer. While verifying and installing required 
software components, Setup displays a dialog similar to the following: 

After all required software components have been verified, Setup displays the following dialog: 
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Click the "Yes" radio button and click the "Next" button to continue. Setup will invoke the Microsoft Windows Installer to complete the installation. The Microsoft Windows Install 
launches the Multi-Objective-OPT Setup Wizard. The Multi-Objective-OPT Setup Wizard will display the following opening dialog: 

Click the "Next" button to continue. The Multi-Objective-OPT Setup Wizard will display the following dialog: 

Click the "Yes" radio button to indicate that you have read, understood and agree to the terms of the license agreement. Note that the license agreement also appears in files 
License.doc and License.rtf in the same directory as Setup.exe, in case you would like to print it. Click the "Next" button to continue. The Multi-Objective-OPT Setup Wizard will display 
the following dialog: 
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The default install folder for Multi-Objective-OPT is C:\Program Files\OPTIMUM Power Technology\MultiObjectiveOPT. If you wish to install to another folder, click the "Change" button 
and specify that folder. Note that Multi-Objective-OPT must be installed to a local hard drive; it may not be installed to a mapped drive or a network drive. If you install for "Just me", the 
default, Multi-Objective-OPT will only be available when your Windows user is logged on to this PC. If you install for "Everyone", Multi-Objective-OPT will be available for any user that 
logs on to this PC. Click the "Next" button to continue. the Multi-Objective-OPT Setup Wizard will display the following dialog: 

Click the "Next" button to start the installation. As the installation progresses, the Multi-Objective-OPT Setup Wizard displays the following dialog: 

When the installation is complete, the Multi-Objective-OPT Setup Wizard displays the following dialog: 
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Click the "Finish" button to terminate the Multi-Objective-OPT Setup Wizard. The Windows Start menu now has the Multi-Objective-OPT group: 

Running Multi-Objective-OPT

Multi-Objective-OPT is launched from the Excel 2003 Tools menu or the Excel Add-Ins tab in the Ribbon. 

The first time you start Multi-Objective-OPT, it will request a serial: 

You must click the "Serial" button and the Serial Dialog will be displayed, and you can enter your Serial. If you do not enter a serial, Multi-Objective-OPT will terminate. 

If a valid Serial is found, the Multi-Objective-OPT dialog is displayed. 

The Multi-Objective-OPT Dialog has Design, Results Options and About tabs and a Close button. Help may be requested by clicking the question mark (?) located on the right side of the 
title bar or by pressing F1. 

Close Button 
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Close will close the window and save the Multi-Objective-OPT information in the worksheet so that it can be used again another time. The workbook must be saved to retain the Multi-
Objective-OPT information with the worksheet. 

Design Tab 

The Design tab has a Task Panel, a DesignSpace Panel, an Optimize button and a Restore Button. 

Task Panel 

The Task panel is where you specify the Objectives for the optimization. You may also specify additional properties to display with the optimization results, Excel macros to execute 
when evaluating a point in the design space, as well as constraints on the Objectives. The Task panel has a tree with Objectives, Constraints, Properties, and Macros nodes and 
buttons that allow you to Add, Remove, or Change a subnodes of the Objectives, Constraints, Properties and Macro nodes. 

Objectives Node 

Each Objective node that appears under the Objectives node displays the Objective type (Minimize, Maximize or Match), the Objective cell, and the Match value for Match type 
Objectives. 

To add an Objective node, click the Objectives node if it is not highlighted, then click the Add button. After the Add button is clicked, the Objective dialog is displayed. The 
Objective dialog is described later in this document. 

To remove an Objective node, click the Objective node you wish to remove, then click the Remove button. 

To change an Objective node, click the Objective node you wish to change, then click the Change button. After the Change button is clicked, the Objective dialog is displayed. 
The Objective dialog is described later in this document. 

Constraints Node 

Each Constraint node that appears under the Constraints node represents an additional criterion that is applied to the Objectives during the course of the optimization. A 
Constraint is a mathematical expression that evaluates to true or false for a given set of values. If the expression evaluates to true, the given set of variable values is included in 
the optimization; if the expression evaluates to false, the set of variable values is excluded from the optimization. Each side of the expression may contain cell specifications, 
constants and operators. 

To add a Constraint node, click the Constraints node if it is not highlighted, then click the Add button. After the Add button is clicked, the Constraint dialog is displayed. The 
Constraint dialog is described later in this document. 

To remove a Constraint node, click the Constraint node you wish to remove, then click the Remove button. 

To change a Constraint node, click the Constraint node you wish to change, then click the Change button. After the Change button is clicked, the Constraint dialog is displayed. 
The Constraint dialog is described later in this document. 

Properties Node 

Each Property node that appears under the Properties node displays displays an Excel cell address or name whose value will be included under the Properties node in the 
Iteration Status window that displays the results when the optimization completes. 

To add a Property node, click the Properties node if it is not highlighted, then click the Add button. After the Add button is clicked, Property Selection dialog is displayed. The 
Property Selection dialog is described later in this document. 

To remove a Property node, click the Property node you wish to remove, then click the Remove button. 

Macros Node 

Each Macro node that appears under the Macros node displays a Macro name that is executed for each set of variable values selected during the course of the optimization. 

To add a Macro node, click the Macros node if it is not highlighted, then click the Add button. After the Add button is clicked, the Macro Selection dialog is displayed. The Macro 
Selection dialog is described later in this document. 

To remove a Macro node, click the Macro node you wish to remove, then click the Remove button. 

To change a Macro node, click the Macro node you wish to change, then click the Change button. After the Change button is clicked, the Macro Selection dialog is displayed. 
The Macro Selection dialog is described later in this document. 

DesignSpace Panel 

The DesignSpace panel is where you specify the values that may be varied to achieve the Objective that you specified in the Task Panel. You may also specify additional 
constraints on these values. The DesignSpace panel has a tree with Variables and Constraints nodes and buttons that allow you to Add, Remove or Change subnodes of the 
Variables and Constraints nodes. 

Variables Node 

Each Variable node that appears under the Variables node represents a cell that is modified during the optimization. 

To add a Variable node, click the Variables node if it is not highlighted, then click the Add button. After the Add button is clicked, the DesignSpaceVariable dialog is displayed. 
The DesignSpaceVariable dialog is described later in this document. 

To remove a Variable node, click the Variable node you wish to remove, then click the Remove button. 

To change a Variable node, click the Variable node you wish to change, then click the Change button. After the Change button is clicked, the DesignSpaceVariable dialog is 
displayed. The DesignSpaceVariable dialog is described later in this document. 

Constraints Node 

Each Constraint node that appears under the Constraints node represents an additional criterion that is applied to a set of variable values that is selected during the course of 
the optimization. A Constraint is a mathematical expression that evaluates to true or false for a given set of variable values. If the expression evaluates to true, the given set of 
variable values is included in the optimization; if the expression evaluates to false, the set of variable values is excluded from the optimization. Each side of the expression may 
contain variable cell specifications, constants and operators. 

To add a Constraint node, click the Constraints node if it is not highlighted, then click the Add button. After the Add button is clicked, the Constraint dialog is displayed. The 
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Constraint dialog is described later in this document. 

To remove a Constraint node, click the Constraint node you wish to remove, then click the Remove button. 

To change a Constraint node, click the Constraint node you wish to change, then click the Change button. After the Change button is clicked, the Constraint dialog is displayed. 
The Constraint dialog is described later in this document. 

Optimize Button 

Clicking Optimize presents the Iterate dialog. The Iterate dialog is described later in this document. 

Restore Button 

After a single Iterate process has completed, Restore will restores each DesignSpace Variable cell to its initial value. After multiple Optimize and Refine processes have completed, 
Restore displays the Restore dialog where you may select whether to restore the previous value or the initial value of each DesignSpaceVariable cell. The Restore dialog is 
described later in this document. 

Multi-Objective-OPT Results Tab

The Results tab shows all Iterations that have completed for the Excel sheet. Information is arranged in a tree with a node for each Iteration appearing under the Excel sheet node. 

Right clicking a node displays the result menu where you can view results for a single Iteration, launch another Iteration, view results for all Iterations, or clear all results. 

Multi-Objective-OPT Options Tab

The Options tab shows a list of checkboxes that correspond to options that you may set. 

Close Iterating form when Iteration Completes Checkbox 

This option corresponds to the Auto-Close Checkbox on the Iterating Dialog. This option is saved and restored across Multi-Objective-OPT starts. 

Save And Reclaim Points From Previous Iterations Checkbox 

This option instructs Multi-Objective-OPT to save Iteration result data across Multi-Objective-OPT starts. If this option is not checked, any Iteration result data will be lost after 
closing the Multi-Objective-OPT dialog. This option is saved and restored across Multi-Objective-OPT starts. 

Show advanced Objective Target Attributes Checkbox 

When this option is checked, Multi-Objective-OPT always displays the Objective Target attributes list in the Objective Dialog. When not checked, the Objective Target attributes list 
is displayed only for Band and Limit Objectives. Checking this option permits entry of advanced Objective Target attributes such as Ceiling, Upper Limit, Cost Over, Cost Under and 
Floor for Minimize, Match and Maximize Objectives. If you change this option, you must restart Multi-Objective-OPT for the change to take effect. 
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Automatically Check For Product Updates Checkbox 

When checked, this option causes Global-OPT to periodically check the OPTIMUM Power Technology FTP site for service packs and if found, gives you an opportunity to download 
a service pack. 

Multi-Objective-OPT About Tab

The Multi-Objective-OPT About tab is displayed if you click the About tab on the Multi-Objective-OPT dialog. The About tab displays the current Multi-Objective-OPT version, copyright 
information, and serial information. In addition, it has a Serial button and a Copy button. 

Serial Button 

Clicking the Serial button displays a New Serial dialog where you may enter a new serial. 

Copy Button 

Clicking the Copy button causes the information displayed on the About tab to be copied to the system clipboard. 

Objective Dialog

The Objective dialog is displayed in response to clicking the Add or Change button on the Objective Panel of the Design tab of the Multi-Objective-OPT dialog while the Objectives 
node or an Objective node is highlighted. The Objective dialog has an Objective Cell textbox, an Objective selection button, an Objective type dropdown, a Weight textbox, a Target 
attribute types list, a Target value textbox or a Target attributes grid, as well as OK, Cancel and Help buttons. 

V (Objective Cell Selection Button) 

After the Objective Cell selection button is clicked, the Objective Selection dialog is displayed. The Objective Selection dialog is described later in this document. 

Objective Cell Textbox 

Objective cell specifies the address of a cell that contains an Objective that will be globally optimized based upon the Objective type. Use the V button, or enter any single cell here. 

Type 

This is a dropdown list that specifies the criteria for finding the global optimum: Maximize, Minimize, Match, Limit or Band. 

Weight 

Weighting can be applied to each Objective of a multi-Objective design Task. The default Weight value is 1. The Weight can be assigned any real value, and all Objective Weights 
are relative to each other. For example, in a two Objective Task assigning Objective one a Weight of 1 and Objective two a Weight of .5 is the equivalent of assigning Objective one 
a Weight of 2 and Objective two a Weight of 1. 

Target Attribute Types 

The Target attribute types list is visible when the Objective type is Limit or Band, or when the Show advanced Objective Target Attributes option is checked on the Options Tab. The 
Target attribute types is a list of checkboxes that represent additional restrictions applicable to the selected Objective Type on allowable Objective values. You may place any 
combination of Ceiling, Upper Limit, Cost Over, Value, Cost Under, Lower Limit, and Floor restrictions on the allowable Objective values. 

Ceiling 

Checking the Ceiling Target attribute type causes the Target attributes grid to be displayed. An additional row (for a single Objective cell) or an additional column (for multiple 
Objective cells) is displayed for the Ceiling value. A Ceiling is a "hard" limit in that an Objective value that is greater than the Ceiling will not be considered for a possible solution. 

Upper Limit 

Checking the Upper Limit Target attribute type causes the Target attributes grid to be displayed. Two rows (for a single Objective cell) or two columns (for multiple Objective 
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cells) are displayed; one for the Upper Limit value and another for the Upper Limit Cost Over value (UL Cost Over). An upper limit is a "soft" limit in that an Objective value that is 
greater than the upper limit value will still be considered for a possible solution except at a reduced weighting as specified by the UL Cost Over value. 

Cost Over 

Cost Over is a weighting factor that is applied when an Objective value exceeds a target Value. Its default value is 1. 

Value 

When visible, the Value target attribute type is always selected. You must specify a match value in the Value textbox, Value column of the Target attributes grid, or the Value row 
of the Target attributes grid for Match or Limit type Objectives. 

Cost Under 

Cost Under is a weighting factor that is applied when an Objective value is less than a target Value. Its default value is 1. 

Lower Limit 

Checking the Lower Limit Target attribute type causes the Target attributes grid to be displayed. Two rows (for a single Objective cell) or two columns (for multiple Objective 
cells) are displayed; one for the Lower Limit value and another for the Lower Limit Cost Under value (LL Cost Under). A lower limit is a "soft" limit in that an Objective value that 
is less than the lower limit value will still be considered for a possible solution except at a reduced weighting as specified by the LL Cost Under value. 

Floor 

Checking the Floor Target attribute type causes the Target attributes grid to be displayed. An additional row (for a single Objective cell) or an additional column (for multiple 
Objective cells) are displayed for the Floor value. A Floor is a "hard" limit in that an Objective value that is less than the Floor will not be considered for a possible solution. 

Tolerance, Tolerance % 

Tolerance and Tolerance % are visible for Band type Objectives. The Tolerance attribute is subtracted and added to the Value attribute to create a band of allowable values for 
the Objective. 

Target Value 

The Target Value textbox is displayed if a single Objective cell is selected and only the Value Target Attribute is checked. Otherwise, the Target Attributes grid is displayed. 

A Match Objective type requires a Target Value to define the value that is to be matched. The Target Value can be assigned any real value. 

Target Values are optional for Maximize and Minimize Objectives. Multi-Objective Tasks will be better met when realistic Target Values are assigned to Maximize and Minimize 
Objectives. 

Target Attributes Grid 

The Target Attributes grid is displayed if multiple Objective cells are selected or if multiple Target Attribute Types are selected. If a single Objective cell is selected, the Target 
Attributes grid has one or more rows for each Target Attribute Type. Otherwise the Target Attributes grid has one or more columns for each Target Attribute Type. 

You may type values in the grid cells for the Target Attributes, or you may right click a grid cell to display a menu that will allow you to import Target Attribute values from the Excel 
Sheet. 

Objective Selection Dialog 

The Objective Selection dialog is presented in response to clicking the Objective Cell Selection button on the Objective dialog. The Objective Selection dialog has an Objective Cell box 
and OK and Cancel buttons. After the Objective Selection dialog is displayed, the Excel worksheet is enabled so you may click the cell that contains the Objective Value for your 
optimization. Clicking a cell causes the cell address to be placed in the Select Objective Cell box. In addition, you may drag across several cells or control-click several cells to specify 
multiple Objective cells. 
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OK Button 

Clicking OK will dismiss the Objective Selection dialog and place the selected cell address in the Objective Cell box of the Objective dialog. 

Cancel Button 

Clicking cancel will dismiss the Objective Selection dialog and not alter the Objective dialog. 

Macro Selection Dialog

The Macro Selection dialog is displayed in response to clicking the Add or Change button on the Task Panel of the Design tab of the Multi-Objective-OPT dialog while the Macros node 
or a Macro node is highlighted. 

In order for Multi-Objective-OPT to access Excel Macros, you may need to adjust the Excel Macro security settings for Excel 2003 or the Excel Trust Center Macro Settings for Excel 
2007 and 2010. In Excel 2003, the checkbox labelled "Trust access to Visual Basic Project" must be checked; in Excel 2007 and 2010, the checkbox labelled "Trust access to VBA 
project object model must be checked. 

The Macro Selection dialog has a Macro listbox, and OK, Cancel and Help buttons. 

Macro Listbox 

The Macro listbox is a list of all Macro names contained in the current Excel Workbook. Click the Macro name you wish to select, then click the OK button. 

OK Button 

Clicking OK will dismiss the Macro Selection dialog and place the information it collected into the Task panel in the Multi-Objective-OPT dialog. 

Cancel Button 

Clicking cancel will dismiss the Macro Selection dialog and not alter the Multi-Objective-OPT dialog. 

Help Button 

Help will bring up this information. 

Property Selection Dialog

The Property Selection dialog is presented in response to clicking the Add button on the Task Panel of the Design Tab of the Multi-Objective-OPT dialog after clicking the Properties 
node. The Property Selection dialog has a Cell box and OK and Cancel buttons. After the Property Selection dialog is displayed, the Excel worksheet is enabled so you may click the 
cell that contains a value that you wish to include in the Iteration Status window. Clicking a cell causes the cell address to be placed in the Select Property Cell box. 

OK Button 

Clicking OK will dismiss the Property Selection dialog and add the selected cell to the Properties node. 

Cancel Button 

Clicking cancel will dismiss the Property Selection dialog and not alter the Properties node. 

DesignSpaceVariable Dialog

The DesignSpaceVariable dialog is presented in response to clicking the Add or Change button on the DesignSpace panel of the Multi-Objective-OPT dialog while the Variables node 
or a Variable node is highlighted. The DesignSpaceVariable dialog has a Cell textbox, a Cell selection button, a Type dropdown, a Current Value box, Minimum and Maximum value 
textboxes, Continuous, Round to, and Increment by radio buttons, Round to and Increment by textboxes, and OK, Cancel and Help buttons. When presented in response to the Add 
button, the DesignSpaceVariable dialog automatically invokes the DesignSpaceVariable Selection dialog. The DesignSpaceVariable Selection dialog is described later in this 
document. 
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V (Cell Selection Button) 

After the Cell selection button is clicked, the DesignSpaceVariable Selection dialog is displayed. The DesignSpaceVariable Selection dialog is described later in this document. 

Cell Textbox 

This specifies the address of the cell that contains the selected DesignSpaceVariable. Use the V button, or any single cell can be entered here. 

Type Dropdown 

The Type dropdown specifies the value type of the DesignSpaceVariable. Supported types include Real, Integer and Binary. Real is any real numeric value. Integer is any integer 
numeric value. Binary variables have the value of 0 or 1. 

Current Value Box 

This displays the current value of the selected DesignSpaceVariable cell. 

Minimum Value Textbox 

This is the minimum value for the selected DesignSpaceVariable cell which limits the size of the DesignSpace 

Maximum Value Textbox 

This is the maximum value for the selected DesignSpaceVariable cell which limits the size of the DesignSpace 

Continuous Radio Button 

Checking this option means that the DesignSpaceVariable may assume any value from the Minimum to the Maximum value. 

Round to Radio Button and Textbox 

Checking this option means that DesignSpaceVariable values will be rounded to the value specified in the Round to textbox. 

Increment by Radio Button and Textbox 

Checking this option means that an increment specified in the Increment textbox will be applied. For example, if a Minimum value of -3 and a Maximum Value of 3 and an Increment 
of 2, DesignSpaceVariable values of -3, -1, 1, and 3 will be considered. 

OK Button 

Clicking OK will dismiss the DesignSpaceVariable dialog and place the information it collected into the DesignSpace panel in the Multi-Objective-OPT dialog. 

Cancel Button 

Clicking cancel will dismiss the DesignSpaceVariable Selection dialog and not alter the Multi-Objective-OPT dialog. 

Help Button 

Help will bring up this information. 

DesignSpaceVariable Selection Dialog

The DesignSpaceVariable Selection dialog is presented in response to clicking the Cell Selection button on the DesignSpaceVariable dialog. The DesignSpaceVariable Selection 
dialog has a Cell box and OK and Cancel buttons. After the DesignSpaceVariable Selection dialog is displayed, the Excel worksheet is enabled so you may click the cell that contains a 
DesignSpaceVariable Value for your optimization. Clicking a cell causes the cell address to be placed in the Select DesignSpaceVariable Cell box. 

OK Button 

Clicking OK will dismiss the DesignSpaceVariable Selection dialog and place the selected cell address in the Cell box of the DesignSpaceVariable dialog. 

Cancel Button 
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Clicking cancel will dismiss the DesignSpaceVariable Selection dialog and not alter the DesignSpaceVariable dialog. 

Constraint Dialog

The Constraint dialog is presented in response to clicking the Add or Change button on the Task panel or the DesignSpace panel of the Multi-Objective-OPT dialog while the 
Constraints node or a Constraint node is highlighted. The Constraint dialog displays the left and right side of the Constraint and has Edit Left Side and Edit Right Side buttons, an 
Operation dropdown and OK, Cancel and Help buttons. When presented in response to the Add button, the Constraint dialog automatically invokes the Constraint Side dialog for the 
Left Side of the Constraint. The Constraint Side dialog is described later in this document. 

Edit Left Side Button 

After the Edit Left Side button is clicked, the Constraint Side dialog is displayed for the Left Side of the Constraint. The Constraint Side dialog is described later in this document. 

Operation Dropdown 

Use the Operation Dropdown to specify the comparison operation to perform between the Left Side and Right Side when evaluating the Constraint. The Operation dropdown 
contains symbols for Not Equal, Greater Than, Greater Than Or Equal, Less Than, and Less Than Or Equal. 

Edit Right Side Button 

After the Edit Right Side button is clicked, the Constraint Side dialog is displayed for the Right Side of the Constraint. The Constraint Side dialog is described later in this document. 

OK Button 

Clicking OK will dismiss the Constraint dialog and place the information it collected into the Task or DesignSpace panel in the Multi-Objective-OPT dialog. 

Cancel Button 

Clicking cancel will dismiss the Constraint dialog and not alter the Multi-Objective-OPT dialog. 

Help Button 

Help will bring up this information. 

Constraint Side Dialog

The Constraint Side dialog is presented in response to clicking the Edit Left Side or Edit Right Side button of the Constraint dialog. The Constraint Side dialog permits you to enter a 
mathematical expression consisting of constants, variables and operators. The Constraint Side dialog has an Expression edit box, a Numeric button group, an Operator button group, 
an Editting button group, and OK, Cancel and Help buttons. 

Expression Edit Box 

The Expression edit box displays the expression that you are editting for the Left Side or Right Side of a Constraint. You may enter information into the expression using the buttons 
or the keyboard. The edit box contains a vertical bar cursor (|). Any information you enter appears to the right of the vertical bar. You may also select information by dragging the 
mouse over a portion of the edit box. Selected information appears highlighted. If text is selected, a keystroke or button click will replace the selected text. 

Numeric Button Group 

The numeric button group contains buttons for the digits 0 to 9, decimal point and PI. Use these buttons to enter a constant. 

Operator Button Group 
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The operator button group contains buttons for addition, subtraction, multiplication, division, exponentiation, and parentheses. 

Editing Button Group 

The editing button group contains a Clear button, a Backspace button, a Delete Button and a Variable button. 

Clear Button 

Clicking the Clear button erases all information from the expression edit box. 

Backspace Button 

Clicking the Backspace button (or the Backspace key) erases one character to the left of the cursor. 

Delete Button 

Clicking the Delete button (or the Delete key) erases one character to the right of the cursor. 

Variable Button 

After the Variable selection button is clicked, the Variable Selection dialog is displayed. The Variable Selection dialog is described later in this document. 

Variable Selection Dialog

The Variable Selection dialog is presented in response to clicking the Variable button on the Constraint Side dialog. The Variable Selection dialog has a Cell box and OK and Cancel 
buttons. After the Variable Selection dialog is displayed, the Excel worksheet is enabled so you may click the cell that contains the Variable that you wish to enter into the constraint. 
Clicking a cell causes the cell address to be placed in the Select DesignSpaceVariable Cell box. 

OK Button 

Clicking OK will dismiss the Variable Selection dialog and place the selected cell address in the expression box of the Constraint Side dialog. 

Cancel Button 

Clicking cancel will dismiss the Variable Selection dialog and not alter the DesignSpaceVariable dialog. 

Iterate Dialog

After clicking the Optimize button on the Multi-Objective-OPT dialog, the Iterate dialog is presented. The Iterate dialog has an Optimize Power panel, an Investigation panel and 
optionally an Exploration panel as well as OK, Cancel and Help buttons. 

Optimize Power Panel 

The Optimize Power panel is where the details of the process used to solve in this problem are specified. There are three main values to be specified: Exploration, Refinement and 
Local Opts. The power level of an iteration is determined by the Design Level which is the sum of the Exploration and Refinement values. The Design Level cannot exceed 30. The 
higher the Design Level the longer the Iteration will take. Also the more Local Opts requested the longer the iteration will require. 

Exploration Textbox 

Exploration is the level from (0 to 29) for the Design of Experiments (DOE) process. The higher the Exploration level the more likely more local optimums will be evaluated by the 
DOE process, and therefore, the more likely the global optimum will be found. Increasing the Exploration number can sometimes increase the iteration time significantly. 

Refinement Textbox 

Refinement is the level from (1 to (30 – Exploration)) is the refinement of the value of any local optimums (including the assumed Global optimum). The higher the Refinement 
number the more refined the result. Increasing the Refinement number normally does not increase the iteration time significantly. 

Local Opts Textbox 

Local Opts is the desired number of solutions. When explorations is 0, only one solution can usually be found. The higher the Exploration number usually the more Local Opts 
can be found. More Local Opts will increase the iteration time, sometimes significantly. 
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Investigation Panel 

Investigation specifies the relative amount of time to spend on the solution to the problem. The Investigation panel has ASAP, Normal and Extensive radio buttons. 

ASAP Radio Button 

ASAP specifies that the quickest possible solution to the problem is desired. 

Normal Radio Button 

Normal specifies that a good solution which may require more time to solve is desired. 

Extensive Radio Button 

Extensive specifies that the best solution regardless of the time required to solve the problem is desired. 

Exploration Panel 

When the Exploration number is sufficiently large the DOE process may require a Monte Carlo solution to reduce the overall time required for the iteration. There are two 
parameters than can be used to specify the amount of Monte Carlo process: Initial Seed Value and Initial Runs. 

Initial Seed Value Textbox 

The initial seed value allows you to generate another iteration with a Monte Carlo solution without changing any other input parameter. This will just start the process from a 
different point in the generation of pseudo random numbers used in most computing situations. 

Initial Runs Textbox 

The Initial runs value allows you to generate a larger DOE process using a Monte Carlo solution. More initial runs will increase the amount of time required to solve the problem. 

Iterating Dialog

After clicking the OK button on the Iterate dialog, the Excel window and Multi-Objective-OPT dialog are hidden and the Iterating dialog is presented. The Iterating dialog has a Status 
Message, a Status box, Auto-Close checkbox, and Cancel and Copy buttons. 

Status Message 

The Status message indicates the current state of the Iterate or Refine process. While busy, it has the text "Iterating". When the current process completes, it has the text "Iteration 
complete". It may also display the text "Iteration cancelled" or "Iteration abended". 

Status Box 

The Status box displays progress messages while the current Iterate or Refine process is running with the most recent progress message at the top. After the current process 
completes, the contents of the Status box may be copied to the system clipboard by clicking the Copy button. 

Auto-Close Checkbox

The Auto-Close checkbox instructs the Iterating dialog to automatically close when the current Iterate or Refine process ends. After the Iterating dialog closes, the Multi-Objective-
OPT dialog and Excel window become visible again. 

Cancel Button 

Clicking the Cancel button prematurely terminates the current Iterate or Refine process. 

Copy Button 

The Copy button is enabled after the current Iterate or Refine process ends. Clicking the Copy button copies the contents of the Status box to the system clipboard. 

Restore Dialog

The Restore dialog is presented in response the clicking the Restore button on the Multi-Objective-OPT dialog if more than one Iterate or Refine process has run. The Restore dialog 
has an Initial Values option button, a Previous Values option button, and OK, Cancel and Help buttons. 

Initial Values Option 
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If you select the Initial Values option and click the OK button, Multi-Objective-OPT restores the initial values of the DesignSpaceVariable cells. These are the values of the 
DesignSpaceVariable cells at the time Multi-Objective-OPT was started. 

Previous Values Option 

If you select the Previous Values option and click the OK button, Multi-Objective-OPT restores the previous values of the DesignSpaceVariable cells. These are the values of the 
DesignSpaceVariable cells before the most recent Iterate or Refine process. 

OK Button 

Clicking the OK button dismisses the Restore dialog and restores the DesignSpaceVariable cells base on the selected option. 

Cancel Button 

Clicking the Cancel button dismisses the Restore dialog and does not alter the DesignSpaceVariable cells. 

Help Button 

Help will bring up this information. 

Serial Dialog

The Serial dialog permits you to enter a new serial. The Serial dialog is presented automatically the first time you start Multi-Objective-OPT and on demand in response to pressing a 
Serial button. The Serial dialog consists of a Current serial textbox, a New serial textbox, and OK, Cancel, and Help buttons. 

Current Serial Textbox 

This textbox displays the current serial that is in effect. This textbox may not be changed. 

New Serial Textbox 

Enter or paste your new serial into this textbox. 

OK Button 

Clicking the OK button dismisses the Serial dialog and validates and installs the new serial. 

Cancel Button 

Clicking the Cancel button dismisses the Serial dialog and does not alter the current serial. 

Help Button 

Help will bring up this information. 

Iteration Status Window
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The Iteration Status screen displays the results of a single iteration. It has a Menu, Title Bar, a Summary Tab, zero or more Result Tabs and zero or more Pareto Analysis Tabs. 

Menu 

The Iteration Status Menu consists of 6 menu items: Pareto Analysis, Export to Excel, Export to File, Copy, Show and Exit. The Iteration Status Menu is also available as a right 
click from the Iteration Status grid or from a Pareto Analysis grid. 

Pareto Analysis Menu Item 

The Pareto Analysis menu item is visible if the current optimization has more than one Objective and the current Iteration has more than 5 Solutions. Clicking on the Pareto 
Analysis item of the Iteration Status menu presents the Pareto Options dialog where you may select the X and Y Objectives for Pareto Analysis. When you click OK on the 
Pareto Options dialog, a Pareto Analysis tab is added to the Iteration Status Window. 

Export to Excel Menu Item 

Clicking on the Export to Excel item of the Iteration Status menu presents the Iteration Status Export Target dialog. 

Copy Menu Item 

Clicking on the Copy item of the Iteration Status menu copies the current Iteration Status window contents to the Windows Clipboard as a set of tab delimited values. You may 
then paste into another application such as Notepad, Word or another instance of Excel. 

Show Menu Item 

Clicking on a Cell in a Column that represents the Base Run or a Solution, then clicking on the Show menu item of the ExpertDesign Status menu causes the Excel Worksheet 
to be updated to show all values associated with the Base Run or Solution. 

Exit Menu Item 

Clicking on the Exit item of the Iteration Status menu closes the Iteration Status Window. 

Title Bar 

The title bar describes which Iteration is being displayed. It shows the name of the Excel spread sheet, Exploration Value, Refinement Value, Local Opts Value, Speed value, Initial 
Seed value (if Monte Carlo was used), Initial Runs (if Monte Carlo was used) and the status of the Iteration. 

Summary Tab

The Summary Tab displays the results of an Iteration in a hierarchical tabular format. It has a grid consisting of rows and columns that are described below. If no other tab is 
applicable to the Iteration, the Summary Tab is not displayed; only the grid is displayed. 

Rows 

The Iteration Status window has a number of collapsible rows. 

Task Row 

The Task row displays the weighted average of each Objective of the run. All Objective values range from 0% (worst case) to 100% (best case). The better the solution, the 
higher the Objective. 

Objective Rows 

Each Objective row displays the value of the Objective component of the Objective. 

Objective Value Rows 

Each Objective Value row contains the cell value after evaluating with the DesignSpaceVariable values from the DesignSpace rows. 

Variable Rows 

Each Variable row contains the cell value associated with the DesignSpaceVariable that was used to obtain the value in the associated Objective Value rows. 

Objective Characteristic Rows 

There are Minimum and Maximum Objective value rows as well as a Solution Gradient row for each DesignSpaceVariable. A Solution Gradient is the partial derivative of an 
Objective value with respect to a DesignSpaceVariable value. 
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Columns 

The first column contains the Row Titles. The first data column is the Base Run, and the subsequent columns are the various solutions found, in descending order by Objective 
value. Only the solutions that were found will be displayed not the number requested. 

Base Run Column 

The Base run is the run produced by the starting values. 

Solution N Column 

Each solution is listed in descending order by Objective value. Only the solutions that were found will be displayed which may be less the number requested. 

Result Tab

A Result Tab is produced for each Match Objective that is an Array. A Result Tab has a Graph and a Legend that consists of one line for the Base Run and lines for each Solution. 

Pareto Analysis Tab

A Pareto Analysis Tab is displayed after you click the OK button on the Pareto Options dialog. A Pareto Analysis tab is a grid of rows and columns that may be exported to an Excel 
sheet and used as a source for a Pareto graph. 

Rows 

The first row of the Pareto Analysis Tab consists of Column Headings. 

The next two rows of the Pareto Anaysis Tab contain the Minimum and Maximum value for each column. 

After the Maximum row, the Pareto Analysis Tab displays rows for Solutions that are on the Pareto Frontier in order from best Y value to the worst Y value as determined by the 
Y percentile value. 

After the Pareto Frontier rows, the Pareto Analysis Tab displays rows for Solutions that are not on the Pareto Frontier in order from best Y value to the worst Y value as 
determined by the Y percentile value. 

Columns 

The first two columns of the Pareto Anaysis Tab contain X and Y Objective values. 

The next two columns of the Pareto Anaysis Tab contain X and Y Objective percentile rankings. 

After the percentile ranking columns, the Pareto Analysis Tab displays error column(s) for Match Objectives. 

Finally, the Pareto Analysis Tab displays a column that indicates whether a particular row represents a Solution that is on the Pareto Frontier. 

Pareto Options Dialog

The Pareto Options dialog is presented in response to clicking the Pareto Analysis menu item. The Pareto Options dialog has an X Objective listbox and a Y Objective listbox as well 
as OK, Cancel and Help buttons. 
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X and Y Objective Listboxes 

The X and Y Objective listboxes include all Objectives that are in the current optimization. Select the Objective for the X and Y axes of the Pareto Analysis and click the OK button. 
The dialog will not permit you to select the same Objective for both the X and Y axis. 

OK Button 

Clicking the OK button dismisses the Pareto Options dialog and displays a Pareto Analysis tab. 

Cancel Button 

Clicking the Cancel button dismisses the Pareto Options dialog and does not alter the current serial. 

Help Button 

Help will bring up this information. 

Iteration Status Export Target Dialog

The Iteration Status Export Target dialog is presented in response to clicking the Export to Excel menu item. The Iteration Status Export Target dialog has a Cell box and OK and 
Cancel buttons. After the Iteration Status Export Target dialog is displayed, the Excel worksheet is enabled so you may click an empty cell that becomes the top left corner of a range 
of cells that will receive the current contents of the Iteration Status Window. 

OK Button 

Clicking OK will dismiss the Iteration Status Export Target dialog and export the contents of the Iteration Status Window to the cell range that you selected. In addition, the contents 
of the Iteration Status Window are placed on the system clipboard and are available to paste into another application. 

Cancel Button 

Clicking cancel will dismiss the Iteration Status Export Target Dialog without exporting any data. 

ExpertDesign Status Window

The ExpertDesign Status screen displays the results of all iterations. It has a Menu, Rows, and Columns. 

Menu 
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The ExpertDesign Status Menu consists of 4 menu items: Export, Iteration status, Show and Exit. 

Export Menu Item 

Clicking on the Export item of the ExpertDesign Status menu presents the ExpertDesign Status Export Target dialog. The Export menu item is also available from a right-click on 
the ExpertDesign Status Window. 

Iteration Status Menu Item 

Clicking on a Cell in a Column that represents an Iteration, then clicking the Iteration Status menu item of the ExpertDesign Status menu presents the Iteration Status Window for 
the Iteration. The Iteration Status menu item is also available from a right-click on a Cell in a Column that represents an Iteration in the ExpertDesign Status Window. 

Show Menu Item 

Clicking on a Cell in a Column that represents the Base Run or an Iteration, then clicking on the Show menu item of the ExpertDesign Status menu causes the Excel Worksheet 
to be updated to show all values associated with the Base Run or Iteration. 

Exit Menu Item 

Clicking on the Exit item of the ExpertDesign Status menu closes the ExpertDesign Status Window. 

Rows 

The ExpertDesign Status window has a number of collapsible rows. These rows display the same data as is displayed in the Iteration Status window. 

Columns 

The first column contains the Row Titles. The first data column is the Base Run, and the subsequent columns represent the best Solution of each Iteration in the order that the 
Iterations were run. 

ExpertDesign Status Export Target Dialog

The ExpertDesign Status Export Target dialog is presented in response to clicking the Export menu item. The ExpertDesign Status Export Target dialog has a Cell box and OK and 
Cancel buttons. After the ExpertDesign Status Export Target dialog is displayed, the Excel worksheet is enabled so you may click an empty cell that becomes the top left corner of a 
range of cells that will receive the current contents of the ExpertDesign Status Window. 

OK Button 

Clicking OK will dismiss the ExpertDesign Status Export Target dialog and export the contents of the ExpertDesign Status Window to the cell range that you selected. In addition, 
the contents of the ExpertDesign Status Window are placed on the system clipboard and are available to paste into another application. 

Cancel Button 

Clicking cancel will dismiss the Iteration Status Export Target Dialog without exporting any data. 

3 Up 3 Down Sample
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This is a modified version of a function called “Peaks” from MATLAB, whose function is: 

f(x,y) = 3*(1-x)CurrentSerial2 * Exp(-(xCurrentSerial2) - (y+1)CurrentSerial2) - 10*(x/5-xCurrentSerial3-yCurrentSerial5) * Exp(-xCurrentSerial2-yCurrentSerial2) - 1/3 * Exp(-(x+1)
CurrentSerial2-yCurrentSerial2) 

This function will result in values from approximately -6.55 to +8.08. 

To run the Example: 

Open Excel and load the 3up3down.xls spread sheet. Be sure that the chart is not the currently selected cell. If the chart is selected then click on any cell on the sheet. 

Click “Add-Ins” then "Multi-Objective-OPT" from the Excel ribbon. 

Click the Add button in the Task panel. This displays the Objective dialog. 

Click the “V” (Objective Cell Selection) button. (this enables the spread sheet so that a cell can be selected) 

Click the spreadsheet cell B6 as the Objective. 

Click the “OK” button. 

Click the “Add” button in the DesignSpace panel. (this opens the DesignSpaceVariable Selection dialog) 

Click on the spreadsheet cell B4 as the first DesignSpaceVariable. 

Click on the “OK” button. (this closes the DesignSpaceVariable Selection dialog leaving the DesignSpaceVariable dialog visible) 

Enter a Minimum value of -3. 

Enter a Maximum of 3. 

Your DesignSpaceVariable window should look the same as the window below: 

Click on the “OK” button. 

Click on the “Add” button. (this opens the DesignSpaceVariable window) 

Click on the “V” button. (this enables the spread sheet so that a cell can be selected) 

Click on the spreadsheet cell B5 as the second DesignSpaceVariable. 

Enter a Minimum value of -3. 

Enter a Maximum of 3. 
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Click on the “OK” button. (this closes the DesignSpaceVariable dialog) 

Click on the “OK” button. 

Your Multi-Objective-OPT window should look the same as the window below: 

Click on the “Optimize” button. 
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